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Chapter 1 – Introduction 

The FaxFinder Fax Client Software lets you deal with faxes in a new and convenient way.  You can now 
send faxes simply by printing files from application programs (word processors, graphics programs, 
Notepad – essentially any program that can print).  You receive fax messages as graphics file 
attachments to email messages from the FaxFinder Administrator or Attendant.  You will view these 
graphics files either using the Multi-Tech Tiff Viewer or, if you prefer, a program of your own that allows 
viewing of TIFF graphics files. This arrangement lets you send and receive faxes at your own desk and 
deal with them entirely electronically if you so choose. 

Accessing the FaxFinder Client Software 

After the FaxFinder Fax Client Software has been installed, it will be on whenever your computer is 
running, unless you specifically turn it off.  An icon for the FaxFinder Fax Client Software will appear in the 
‘tray’ area in the lower right corner of your computer screen.   

 

You must click on this icon and select “show FaxFinder Client Software” to make the program’s main 
screen visible.  You can also start the FaxFinder client software from the Start | Programs menu. 

Main Screen of FaxFinder Fax Client Software 

 
 

However, you can send and receive faxes without viewing the main screen. 
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Sending Faxes 

To send a fax from an application program, you must change that application program’s target printer to 
“Multi-Tech FaxFinder” (this option becomes available as soon as the FaxFinder client software is 
installed on your PC).  Then, when you invoke the Print command from your application software, the 
document will be effectively scanned or “captured” electronically in preparation for going out as a fax -- 
instead of being printed on paper.  Shortly after you invoke the Print command, the FaxFinder Send Fax 
screen will appear.  That’s where you specify the recipient(s) of the fax message. 

 

The FaxFinder Send Fax screen also lets you add common items to the fax message:  a cover page, a 
brief comment, etc.  The FaxFinder Fax Client Software also includes an Address Book in which you can 
store information about parties to whom you may regularly send faxes.  The FaxFinder Send Fax screen 
gives you access to the Address Book so that all of the recipient’s contact information (company name, 
street address, voice phone number, etc.) can be added automatically. 
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Receiving Faxes 

To receive a fax from the FaxFinder system, you simply open the email message received from the 
FaxFinder Administrator or forwarded from a party who serves as a “FaxFinder Attendant” for your 
network.  The way you receive fax emails (either directly from the Administrator or as forwarded from the 
Attendant) depends on the kind of phone service you have (whether through a PBX or not and depending 
also on PBX features).  The fax email you receive will open either into the Multi-Tech Tiff Viewer program 
or another TIF-viewing program that you specify.  You can then view the fax message, print it, save it, 
forward it, etc., as needed. 

These are the basics about FaxFinder.  The FaxFinder Fax Client Software has many capabilities.  This 
manual describes them and shows examples of how they work.  You will find sections on most common 
operations in the table of contents.  We also present detailed descriptions of each software screen. 

The FaxFinder is really pretty easy to use.  We hope you enjoy it.  If you have problems, call our Tech 
Support Department at 1-800-972-2439. 

 

Related Manuals 
 

The FF200 FaxFinder hardware unit comes with 4 manuals that serve different purposes: 

Title Format Purpose 

Administrator User Guide 
 

on CD Presents comprehensive info about FaxFinder 
unit, server software, & client software. 

FaxFinder Reference Guide 
(IP Office PBX Interface) 

on MTS 
web site 

FaxFinder Administrator should use this 
manual to configure the FaxFinder unit in 
conjunction with the Avaya IP Office PBX.   

Client User Guide 
   (this manual) 

on CD Comprehensive user info for FaxFinder clients. 

Client Operation Primer on CD Brief instructions for sending and receiving 
faxes via the FaxFinder system.  Multi-Tech 
recommends that you print out a copy of this 
document for each user. 

Quick Start Guide in print FaxFinder Administrator should use this 
manual to configure the FaxFinder unit, the 
server software, and software for each client. 

 

Client users of the FaxFinder system should expect to receive electronic files of the Client User Guide 
and the Client Operation Primer from the FaxFinder administrator.  Print out these manuals in whole or in 
part as needed. 

Multi-Tech manuals and other resources are available on the Multi-Tech Web page at 
http://www.multitech.com. 
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Chapter 2 – FaxFinder Client Software 
Configuration 

To configure the FaxFinder Client Software, you must first install the software on a PC and then associate 
that installed client software with one or more specific FaxFinder hardware units. 

 

Installing FaxFinder Client Software 
 
1. Insert the FaxFinder Product CD into the CD-ROM drive of the client PC.  Launch the installation 
program by clicking on the setup.exe file on the CD.  Transient screens will appear. 
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2. At the Welcome screen, click Next. 
 

 
 
3. At the Choose Destination Location screen, designate the desired file location for the FaxFinder 
client software.  In most cases, the default file location is recommended. 

 
 
Specify the desired file location and click Next. 
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4. At the Select Program Folder screen, you can designate a program folder for the FaxFinder software.  
Again, in most cases, the default is recommended unless you have other plans. 

 
 
Designate a folder and click Next. 
 
5. A transient screen will appear while files are being copied. 
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6. You will be asked whether or not you want to associate TIF and CPG files with the Multi-Tech Tiff 
Viewer.  Click Yes (unless you prefer to use a different viewer program). 
 

 
 
7. If a Question screen appears asking "Warning - the extension TIF is already registered, Overwrite?,” 
you must respond.  Click Yes if you wish to use the TIFF viewer installed with the FaxFinder Client 
Software.  Click No if you prefer to use a different software package for viewing TIF files. 
 

 
 
8. Then the ‘completion’ screen will appear.   

 
 
Click Finish. 
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The FaxFinder Fax Client Software starts automatically when the installation is complete. 
 
Icons for the FaxFinder software applications will appear in the Windows Start menu.  After installation, 
the Client Software starts up whenever the computer is booted. A FaxFinder icon appears in the tray area 
at the lower-right corner of the screen.  The FaxFinder Fax Client Software screen can be opened from 
either the Start menu icon or the tray icon.  (If the Client Software is shut down, it can be re-opened from 
the Start menu or by double-clicking on the FF110.EXE file, which, following a typical, default installation, 
would be located at C:\Program Files \ Multi-Tech Systems\FaxFinder Client Software\.) 
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Associating Client with Specific FaxFinder Unit(s) 
Sometimes more than one FaxFinder unit is connected to an Ethernet network.  In some cases, certain 
client users might be assigned to some FaxFinder units and not assigned to others.  After the FaxFinder 
client software is installed, you must associate it with one or more FaxFinder units.  This procedure shows 
you how to make this association so that faxes may be sent from a particular FaxFinder unit to the email 
inbox of your PC.  To do this procedure, you will need to know the IP address of the FaxFinder unit.  Be 
aware that an individual FaxFinder client user can be associated with more than one FaxFinder unit.  This 
could easily be the case in an office that is large and/or an office that has a great deal of fax traffic.  

1.  At the main screen of the FaxFinder Fax Client Software, click on Edit and select “Add FaxFinder.” 

 
2.  At the Add FaxFinder Address screen, in the “Enter Address” field, enter the IP address or domain 

name of the FaxFinder unit that the client will use. 

A client can be associated with more than one FaxFinder unit, but the associations must be 
established one at a time. 

 
3. Enter, in the appropriate fields, the Username and Password that the client will use when accessing 

this FaxFinder unit.  If the client is to be associated with multiple FaxFinder units, a different 
Username and Password could be established for each.  However, in most cases, it is advisable (for 
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the sake of simplicity and convenience) to use the same Username and Password for all FaxFinder 
units.   

NOTE:  The Username entered here must match the entry used in the “User ID” field of the Phone 
Book screen in the FaxFinder Server Software.  The password entered here must match 
the password entered for this client in the Password Administration screen in the 
FaxFinder Server software. 

Click OK. 

4. A new FaxFinder entry should appear on the “Device Status” tab of the FaxFinder Fax Client 
Software screen.   

 
The status of the newly registered FaxFinder unit should momentarily go from “Logging in” to “Idle.”  If 
it goes to Login Failure, then one of two things is wrong: 

a. The IP address or domain name is wrong. If that is the case, delete that entry (by right-click 
DELETE), and enter a new one; otherwise, 

b. The Username/Password combination may be wrong.  Verify that the Username/Password 
combination in the client software screen matches the UserID/Password combination established in 
the FaxFinder Server software screen. 
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Dis-Associating the Client from a Specific FaxFinder Unit 
In this procedure, you will un-do the procedure “Associating Client with a Specific FaxFinder Unit.”  This 
situation might occur when changes are being made in the network faxing system.  In any event, this 
procedure severs the tie between your PC and a specific FaxFinder unit so that you will no longer be 
connected to it for sending fax messages. (Faxes can be received in email form from the FaxFinder 
server, despite dis-associating from the FaxFinder server, as long as the receiving party is entered in the 
FaxFinder Phone Book.)  In cases where the client is currently associated with more than one FaxFinder 
unit, you will need to know the IP address of the specific FaxFinder unit from which you want to 
disconnect. 

1. Open the FaxFinder Client Software program and go to the Device Status tab.  Select the 
FaxFinder unit from which you want to disconnect (you can identify the FaxFinder unit by its IP 
address or domain name).  Right-click on it and select delete. 

 
2. Your FaxFinder Client Software will no longer be able to send faxes through this particular 
FaxFinder unit. 
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Disabling and Re-Enabling a Client’s FaxFinder Service 
Disabling a FaxFinder’s service to a specific client is simply a temporary version of dis-associating 
the client from that FaxFinder.  When a client has disabled the FaxFinder’s service to that client, the 
client/user cannot send faxes through the FaxFinder.  (Faxes can be received in email form from the 
FaxFinder server, despite this disabling, as long as the receiving party is entered in the FaxFinder 
Phone Book.)  The client can easily re-establish FaxFinder service by toggling the Disable command 
(now shown with a “ ” beside it), thus enabling service once again. 

1. Open the FaxFinder Client Software program and go to the Device Status tab.  Select the 
FaxFinder unit from which you want to disconnect temporarily (you can identify the FaxFinder unit by 
its IP address or domain name). Right-click on it and select disable. 

 
2. When disabled, a check mark will appear beside the disable command. 

3. To re-enable the FaxFinder unit for your use, that is to avail your PC of its service once again, 
open the FaxFinder Client Software program and go to the Device Status tab.  Select the FaxFinder 
unit to which you want to re-connect.  Right-click on it and select   disable.  You will now be re-
connected to service by this FaxFinder unit. 

 

Sending Test Fax 
To verify that the software installation has succeeded, you should use the FaxFinder client software to 
send a fax to a regular fax machine (preferably a local fax machine).  To do so, follow the instructions for 
the “Sending a Fax” procedure in Chapter 6.   
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FaxFinder Fax Client Software Menu Command Definitions 
 

 
 

FaxFinder Fax Client Software Menu Command Definitions 

Command Name Values Description 

File menu commands  
Send Fax -- Brings up the FaxFinder Send Fax screen, the 

first step in transmitting a fax message via the 
FaxFinder system. 

Pause Scheduler -- When you invoke the Pause Scheduler 
command, any faxes currently pending will not 
be sent and any fax transmissions attempted 
while this command is in force will not be sent.   
When the scheduler has been paused, you must 
select  Pause Scheduler to rescind the 
command. That is to say, this command toggles 
on and off when selected repeatedly. 
If the computer is rebooted, the FaxFinder Fax 
Client Software will cancel the Pause Scheduler 
command at startup.  Any faxes that had been 
paused and left unsent when the computer was 
turned off will be sent immediately when the 
computer is turned on again. 

Options  Brings up the Options screen.  The Options 
screen consists of the Identification tab where 
info about the client user should be entered and 
the Fax Retry tab where the client user can 
specify, for faxes that were not successfully on 
the first attempt, the number of subsequent 
attempts to be made and the interval between 
these attempts. 

Exit  Closes the FaxFinder Fax Client Software 
program. 
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FaxFinder Fax Client Software Menu Command Definitions (cont’d) 
Command Name Values Description 

Edit menu commands  
Add FaxFinder -- Brings up the Add FaxFinder Address screen 

so that a FaxFinder on the network can be 
associated with the client.  A client can be served 
by more than one FaxFinder unit. 

Add Contact -- Brings up the New Contact screen so that an 
recipient can be added to the Address Book.  
Once a recipient’s contact info has been entered 
into the Address Book, faxes sent to that party 
will have the destination fax number 
automatically conveyed to the FaxFinder unit.  
Info from recipient’s Address Book entry will also 
be included in automated fields on fax cover 
pages where applicable (for example, the voice 
phone number, company name, and city of the 
recipient might be two fields included on the 
cover page). 

Edit Cover Page 
Template 

-- Brings up the Cover Page Generator program so 
that fax cover pages can be created or modified. 

Help menu commands Not currently supported.  See User Guides. 
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FaxFinder Fax Client Software Menu Command Definitions (cont’d) 
Field Name Values Description 

Device Status tab  

Device (column) alphanumeric Shows FaxFinder units with which the client is 
associated.  Also shows Print Capture function.  

Status (column) idle, negotiating, 
preparing to 
capture, capturing 
page n, sending 
fax page n, 
receiving fax page 
n, success, 
unsuccessful- user 
aborted, 
unsuccessful-no 
carrier, 
unsuccessful- no 
dial tone, 
unsuccessful-error 
<descriptor> 

Shows the status of the FaxFinder fax server unit 
pertaining to its fax sending and receiving 
capabilities and to its print/image capturing 
capabilities. 

Recipient (column) alphanumeric Shows the name and fax number of recipient to 
whom fax is currently being sent. 

Print Capture (row) idle,  
preparing to 
capture,  
capturing page n 

Indicates status of the FaxFinder’s Print 
Capturing software module. 
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FaxFinder Fax Client Software Menu Command Definitions (cont’d) 

Command Name Values Description 
Device Status tab (cont’d)  

Commands accessed by 
Right-Clicking on a 
selected FaxFinder 

  

Delete  Dis-associates the client from the selected 
FaxFinder unit so that the client can no longer 
send faxes through that FaxFinder unit. (The 
FaxFinder Server’s IP address is removed from 
the Device Status list of the FaxFinder Client 
Software.) 

Disable -- Temporarily dis-associates the client from the 
selected FaxFinder unit so that the client can no 
longer send faxes through that FaxFinder unit. 
To restore the connection to the FaxFinder unit, 
select  Disable. (Because the FaxFinder 
Server’s IP address remains in Device Status list 
of the FaxFinder Client Software, service can be 
restored by toggling the Disable command, thus 
enabling the association once again.) 

Abort -- Discontinues a fax transmission in progress. 
Abort and Pause -- Discontinues a fax transmission in progress and 

puts all pending faxes on hold.  After this 
command has been invoked, no more faxes will 
be sent from this client until  
(a) the client PC is turned off and on again, or  
(b) the command has been turned off by 
selecting  Pause Scheduler in the File menu 
of the FaxFinder Fax Client Software.  

Update -- Brings up a login screen requiring administrative 
rights.  After a successful login, screens appear 
that allow the firmware of the FaxFinder unit to 
be updated.  You can update the POTS modem 
firmware and/or the FaxFinder server firmware. 
Each of these entails a separate update.  
Updated firmware must be in hand before 
beginning the update. Administrative rights are 
required to update the firmware.  See “Updating 
FaxFinder Firmware” in Ch7: Server Operation in 
Administrator User Guide. 

Properties -- Brings up the FaxFinder <IP address><domain 
name> screen.  This screen simply shows the IP 
address or domain name of the selected 
FaxFinder unit. 
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FaxFinder Fax Client Software Menu Command Definitions (cont’d) 
Field/Command Name Values Description 

Pending Faxes tab  

Recipient (column) -- Identifies recipient of each fax for which 
transmission is incomplete.   

Scheduled Time/Date -- Identifies time at which a pending fax is set to be 
transmitted.   

Pages (column) -- Shows the number of pages of each fax. 
Commands accessed by 
right-clicking on a 
selected pending fax 
message 

  

Delete -- Cancels the transmission of the selected pending 
fax message. 

Reschedule -- Brings up the Fax Scheduling screen so that 
transmission of a pending fax can be scheduled 
for a different time. 

Properties -- Brings up the Fax Details screen for the selected 
pending fax .  The Fax Details screen presents 
information about the recipient, transmission 
status, cover page, and original source file of the 
selected pending fax.   
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FaxFinder Fax Client Software Menu Command Definitions (cont’d) 
Field Name Values Description 

Fax Ports tab  

Device (column) alphanumeric Shows FaxFinder units with which the client is 
associated.   

Port (column) ttys0, ttys1 The fax modem (within) the FaxFinder server 
unit, the status of which is being tracked.   
ttys0 denotes POTS Modem 1 of the listed 
faxfinder unit; 
ttys1 denotes POTS Modem 2 of the listed 
faxfinder unit. 

Status (column) idle, negotiating, 
preparing to 
capture, capturing 
page n, sending 
fax page n, 
receiving fax page 
n, success, 
unsuccessful- user 
aborted, 
unsuccessful-no 
carrier, 
unsuccessful- no 
dial tone, 
unsuccessful-error 
<descriptor> 

Shows the status of the FaxFinder fax server unit 
pertaining to its fax sending and receiving 
capabilities and to its print/image capturing 
capabilities. 

Recipient (column) alphanumeric Shows the name and fax number of recipient to 
whom fax is currently being sent. 

List All Fax Ports  Y/N When selected, all fax ports are listed; when not 
selected, only the current active fax port is listed. 
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FaxFinder Fax Client Software Menu Command Definitions (cont’d) 
Field/Command Name Values Description 

Fax Log tab  
Recipient (column)  Identifies recipient of each outgoing fax. 
Time/Date Sent (column) day, date, time, zone

in the form 
ddd mmm nn 
hh:mm:ss zzzzzz  

Indicates when each outgoing fax was sent. 

Pages (column) integer Shows the number of pages in each fax. 
Status (column) success, 

unsuccessful- user 
aborted, 
unsuccessful-no 
carrier, 
unsuccessful- no 
dial tone, 
unsuccessful-error 
<descriptor> 

Indicates whether each fax was sent successfully 
or not and, if not, indicates reason for failure. 

Commands accessed by 
right-clicking on a 
selected fax log entry 

  

delete -- Cancels the selected fax log entry. 
resend -- Resends the selected fax.  The Fax Scheduling 

screen will appear to set a time for the resending 
to occur. 

properties -- Brings up the Fax Details screen for the selected 
fax.  The Fax Details screen presents information 
about the recipient, transmission status, cover 
page, and original source file of the selected 
pending fax. 
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FaxFinder Fax Client Software Menu Command Definitions (cont’d) 
Field/Command Name Values Description 

Address Book tab  
Name (column) alphanumeric Shows the name of the the selected Address 

Book entry. 
Organization (column) alphanumeric  Shows the organizational affiliation of the the 

selected Address Book entry. 
Fax Number (column) integers Shows the fax number of the selected Address 

Book entry. 
   
Commands accessed by 
right-clicking on a 
selected address book 
entry 

  

delete -- Removes the selected entry from the Address 
Book.  A confirmation screen appears before the 
deletion is executed.  

properties -- Brings up the Contact <name> screen screen 
for the selected address book entry.  The 
Contact screen shows user contact details 
(name, company name, fax number, phone 
numbers, and street address info). 
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Chapter 3: FaxFinder Client Software 
Operation 

 
This chapter describes the things that a client user can do with the FaxFinder system.  Three software 
programs are involved: the FaxFinder Client Software, the Multi-Tech Tiff Viewer, and the Multi-Tech 
Cover Page Generator.  The programs work together with the FaxFinder Client Software acting as the 
hub of activity.  The FaxFinder Client Software interfaces with the FaxFinder Server, has a user interface, 
and calls upon the Cover Page Generator and Tiff Viewer for their special functions.  When sending 
faxes, the FaxFinder Client Software calls up the Multi-Tech Cover Page generator if cover pages are 
requested.  When previewing outgoing faxes or viewing received faxes, the PC’s operating system calls 
up the TIFF Viewer to display TIFF files.  Note that client users can choose to display TIF files on a 
different TIF viewing program (see Step 7 of “Installing FaxFinder Client Software” in Chapter 2). 

 



Chapter 3 – FaxFinder Client Software Operation 

Multi-Tech Systems, Inc.             FF200 FaxFinder Client User Guide 25 

Sending a Fax 
To send a fax by printing from an application program on a client PC, follow the steps listed below. 

1.  The FaxFinder client software must be installed on the PC. (See the section “Installing FaxFinder 
Client Software” earlier in this manual.) 

2.  The client PC and the FaxFinder server must both be connected to the same Ethernet LAN system. 
(See the section “Part B: Configuring the FaxFinder Server” earlier in this manual.) 

3.  The association must be made between the client PC and the FaxFinder Server. (See the section 
“Associating Client with Specific FaxFinder Unit(s)” earlier in this manual).   

4.  After installation, the FaxFinder Fax Client Software program will be running whenever the PC is 
on. You can view the FaxFinder program's main window by clicking on the FaxFinder icon at the 
lower right of the PC’s monitor screen in its Application Tray. Then select “Show FaxFinder Client 
Software.”  

Note: The user can shut down the FaxFinder program by selecting "exit" either 
from the tray icon or from the main FaxFinder program screen.  If the 
program has been shut down, it can be restarted from the Windows Start 
menu.)   
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However, you can send faxes through the FaxFinder without bringing up the FaxFinder Client 
Software screen. 
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5. At the application program (for example, a word processing program or drawing program), print to the 
FaxFinder. 

Setting the destination of the printing job varies from program to program.  For the common Notepad 
text editor program, for example, you must set the destination printer in the Page Setup screen.  In 
most cases, however, the destination printer can be set in a Print menu that appears when each 
printing job is initiated. 

 
 

     Application programs may sometimes ‘complain’ about the image size not fitting on the fax page.  
Although such messages can sometimes safely be ignored (in the illustration below, simply by 
clicking “Yes” to proceed), you must confirm this with your own application programs. 

 



Chapter 3 – FaxFinder Client Software Operation 

Multi-Tech Systems, Inc.             FF200 FaxFinder Client User Guide 28 

To assign the FaxFinder as the default printer simultaneously for all application programs that print, 
use the Windows Printers dialog box. 

 
 

To adjust fax-specific parameters (like resolution and paper size), right-click on the Print dialog box 
within the application and select “Properties.”  The MULTI-TECH FAXFINDER Properties screen will 
appear. 
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6. After the printing has been initiated by the application program, the FaxFinder Send Fax screen will 
appear.     

 
Click on Address Book.  When the Address Book screen appears, click “Add.”  At the New 
Contact screen, enter the recipient’s name, fax number, and any other contact information you want 
to retain.   

The recipient’s fax number should be entered as you would dial it from a phone on the public phone 
network (as from a residential phone).  Click OK.  At the Address Book screen, highlight the 
recipient in the list and click “Select.”  The party will appear in the “Recipients” list in the FaxFinder 
Send Fax screen. 

Additional recipients can be added.  The same fax message will be sent to all recipients. 

A recipient can also be specified directly in the FaxFinder SendFax screen by typing his/her name in 
the “Name” field, typing his/her fax number in the “Phone Number” field, and then clicking on “Add 
Recipient.”  If the recipient is specified in this way, the user will be prompted about entering the 
recipient in the Address Book but such recipients will not be added to the Address Book 
automatically. 

You can also access the Address Book directly to add and edit entries.  At the FaxFinder Fax Client 
Software screen, go to Edit | Add Contact. 

7. If you want to include a cover page with your fax, click in the “Use Cover Page” checkbox.  Enter 
information as needed in the “Subject” and “Cover Page Notes” fields.   

Automated fields, like sender information (individual name, company name, street address, phone 
number, fax number, etc.) should be entered in the Address Book.  The Address Book is accessible 
in the “Options” menu of the FaxFinder Fax Client Software screen.  For more information about 
addresses and the automated fields used in cover pages, see the section “Setting Up Your Address 
Book” later in this chapter.      
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The “Cover Page Style” chosen will determine how this information will appear on the fax cover page.  
You can select a standard style from the “Cover Page Style” drop-down menu or create a style of 
your own in the Template Editor.  To access the Template Editor software, click on the “View/Edit” 
button.  (For more information, see the section “Creating or Modifying Cover Page Styles” later in this 
chapter.)     

 

Click on the “Preview Fax” button to check the fax before you send it. The Mult-Tech Tiff Viewer 
program will appear.   

 

 
In it, you can view both the cover page and the main fax page(s).  (For more information on this, see 
the section “Using the Multi-Tech Tiff Viewer” later in this chapter.)  When satisfied with your fax, 
close the Multi-Tech Tiff Viewer program and return to the FaxFinder Send Fax screen. 

8. At the FaxFinder Send Fax screen, click on the “Send Fax Now” button to send the fax. 

 

9. Confirmation of having sent the fax(es) successfully will appear in the “Fax Log” tab of the FaxFinder 
Fax Client Software screen. 
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Scheduling Fax Transmissions 
The FaxFinder allows you to send a fax immediately or delay its transmission until a later time.  Perhaps 
the most common motivations for delayed faxing are to enjoy the lower phone rates that may apply at 
night and on weekends or to broadcast faxes after business hours to avoid tying up fax transmission 
resources during the busiest weekday hours.  In any case, it is easy to schedule faxing for a later time. 

1. Send the fax via FaxFinder in the normal way (see the procedure “Sending a Fax” earlier in this 
chapter).   

2. When the FaxFinder Send Fax screen appears, enter a recipient for the fax either from the Address 
Book or by entering Name and Phone Number (fax number) in the appropriate fields and clicking Add 
Recipient. 

3. In the FaxFinder Send Fax screen, the recipient’s name and fax number will appear in the “Recipients” 
list and the “Schedule” pane will no longer be grayed out.  Click Schedule.  The Fax Scheduling screen 
will appear. 

 
4. Click to uncheck the “send immediately” checkbox. 

5. Enter the date and time at which you want the fax to be sent. 

6. Click OK in the Fax Scheduling screen and then click Send Fax in the FaxFinder Send Fax screen. 
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7. The fax will be sent at the scheduled time.  You can view the event as it happens in the FaxFinder 
client software Device Status screen or after the fact in the Fax Log screen. 

 

 

Re-Sending a Failed Fax 
Locate the failed fax in the Fax Log tab of the FaxFinder Fax Client Software.  Select the failed fax and 
right-click on it.  In the menu that appears, select Resend. 
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Putting Pending Faxes on Hold and Rescinding the Hold 
Suppose you have sent a fax to 10 recipients and, shortly after clicking on Send Fax, you realize that 
there is something incorrect in the content of your fax (it may be something you want to add, delete, or 
change). You can prevent any pending faxes from being sent by selecting “Pause Scheduler” in the File 
menu of the FaxFinder Fax Client screen.  Suppose that 2 faxes have already been transmitted 
completely and a third fax is in progress when you click “Pause Scheduler.”  The FaxFinder will finish the 
third fax but will not fax to recipients 4-10.  The pausing function allows you to see details about the fax, 
to view the fax again, and to delete the fax if you so desire.   

As long as “Pause Scheduler” is selected, no fax message will advance beyond “Pending” status and, so, 
none will be sent. 

To rescind or call off the hold on pending faxes, open the FaxFinder Fax Client Software.  From the File 
menu, select   Pause Scheduler.  The scheduler will resume normal operation and faxes will be sent. 

Consider this example.   

1. A fax is sent by FaxFinder to three recipients. 

 
2. While the fax is being sent to the second party, the client user realizes that there is something wrong 
with the fax.  She brings up the FaxFinder Fax Client Software screen, opens the File menu, and selects 
“Pause Scheduler.”   
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At that point, the FaxFinder will complete the fax in progress that is being sent to the second recipient. 
However, the fax to the third recipient is still listed as “Pending” in the Pending Faxes tab of the 
FaxFinder Fax Client Software. 

 
The client user can take one of several actions.   

She could click on “Pause Scheduler” again to cancel that command.  In that case, the pending fax would 
become active and could not be stopped. 

She could select the fax in the Pending Faxes screen and right-click on it to bring up a menu. 
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She could view the details of the fax and, at her option, view the fax again. 

 
She could re-schedule the fax for a later time. 
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She could “delete” the fax, which means that that fax transmission would never be completed. 

 
 

Pause is canceled on reboot.  If she shuts down her computer for the day while leaving this fax in a 
“pending” state, that fax will be sent shortly after booting up her computer again, that is shortly after the 
FaxFinder client software is functioning again.  So, any faxes put in the pending state by using the  
‘Pause Scheduler’ command will be sent the next time the FaxFinder software is activated. 

 

Canceling a Fax 
If the fax is in progress …  Open the FaxFinder Fax Client Software.  On the Device Status tab, select 
the FaxFinder unit that is in the process of sending your fax.  In the list, right-click on that FaxFinder entry.  
In the menu that appears, select Abort. 

If the fax is pending …  Open the FaxFinder Fax Client Software.  On the Pending Faxes tab, select the 
fax transmission that you want to cancel.  In the list, right-click on that fax message entry (the recipient 
will be shown).  In the menu that appears, select Delete. 

To cancel the current fax and simultaneously put a hold on sending any other faxes from your PC, select 
Abort and Pause.  To resume faxing, go to the File menu and cancel the pause by selecting   

 Pause Scheduler.  Any pause applied to a pending fax is cancelled when the computer is rebooted.  
Any fax left pending with the FaxFinder Scheduler paused will be sent as soon as the FaxFinder client 
program opens when the PC is turned on again.   
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Setting Fax Retry Number and Interval 
You can set the FaxFinder client software to retry a fax transmission if it fails on the first attempt.  You can 
set both the number of additional attempts and the interval between each additional attempt.  You can set 
these parameters as follows. 

1. In the FaxFinder Fax Client Software screen, open the File menu and select “Options.”  When the 
Options screen appears, click on the Fax Retry tab. 

 
2. Set the number of retries and the interval between these repeated attempts and click OK. 
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Sending One Fax Containing Multiple Documents 

The FaxFinder allows you to include multiple documents in a single fax transmission.  Those multiple 
documents could come from the same or different application programs.   

1. Consider the example below where a text file and a drawing file are included in the same fax with a 
single cover letter. Here’s how this multiple-document fax was sent.  

a. The user printed the text file to the FaxFinder from the Notepad text editor program. 

b. The FaxFinder Send Fax screen appeared.  However rather than completing the fax 
transmission, the user opened another application program. 

c. The user printed the graphic file to the FaxFinder from the MacroMedia FreeHand drawing 
program.   

d. When the user returned to the FaxFinder Send Fax screen, both documents appeared in the 
“Documents” list. 

 

2. In the “Documents” pane of the FaxFinder Send Fax screen, you can add a cover page, re-arrange 
the order of the files, or delete items from the list of files to be faxed. 
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3. You can also add to the list of files to be faxed out by including items that you have stored.  In the 
“Documents” pane of the FaxFinder Send Fax screen, click Add.  You could then browse to find, for 
example, a fax that you had received earlier, had stored as a TIF file, and now want to forward to another 
party.  

 

4. When all documents to be transmitted have been listed in the Documents list, click Send Fax.  The 
documents will be sent in the order listed. 
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Forwarding a Fax 
Suppose you receive a fax using the FaxFinder system.  Suppose that fax message is something you 
want to pass along to another party in fax form at a later date (for example, Rocky Mountain Construction 
Company receives tax information about lots on which it intends to build houses).  In this case, you 
should note the name of the TIF file in question.  You can then browse to that TIF file and  re-send it as a 
fax message.  

To forward a fax, follow these steps. 

1. At the FaxFinder Fax Client Software screen, go to the File menu and select “Send Fax.”  The 
FaxFinder Send Fax screen will appear. 

2. In the Documents pane, click “Add.”  Then browse to the TIF file to be sent as a fax.      

 
Click Open. 

3. The selected file will appear in the “Documents” list in the FaxFinder Send Fax screen.     
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4. In the FaxFinder Send Fax screen, specify a recipient for the fax.  The recipient could either come 
from your Address Book or be entered by typing the Name and Phone Number in the appropriate 
fields and clicking “Add Recipient.”     

 

Then click Send Fax.  The TIF file will be reconverted into a fax message that can be received by a fax 
machine. 
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Receiving a Fax 
The FaxFinder Server delivers incoming faxes to client PCs in their email inboxes.  

Since faxes received through the FaxFinder are transformed into email attachments, they can be directed 
anywhere email goes.  The final recipient can be inside the office or across the ocean. 

Fax reception works differently when the FaxFinder is operating in PBX Routing Mode than in POTS 
Mode.  In PBX Routing Mode, faxes come directly to client/users; in POTS Mode, all faxes come to an 
attendant who forwards them to the intended recipient. 

Receiving Faxes in POTS Mode 

In POTS Mode, all faxes are emailed to an attendant using a single fax number.   

1. The incoming fax arrives in the attendant’s email inbox as a message with an attachment.   

2. The attendant uses email to forward the message to the appropriate recipient.  Recipients could be on 
the local Ethernet network or outside of it.   

3. The recipient opens the email message.  The incoming fax message takes the form of a graphic file 
attachment.  The FaxFinder Server has assigned the file an automatic file name. 

4. The incoming fax arrives in the client’s email inbox as a message with an attachment. 

The email message is marked as being from the FaxFinder Administrator. 

The sender’s “Remote ID” and the client’s name appear in the “Subject” line of the email message.  
(The Remote ID comes from the sending fax machine and is typically the sender’s fax number or 
name.)    
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Chapter 3 – FaxFinder Client Software Operation 

Multi-Tech Systems, Inc.             FF200 FaxFinder Client User Guide 44 

5. The FaxFinder client opens the email message.  The incoming fax message takes the form of a 
graphic file attachment.  The FaxFinder Server has assigned the file an automatic file name. 

 
6. The FaxFinder client can open the file or save the file. 

a. Opening the fax message graphic file.  Incoming fax messages are TIFF files.  These TIFF files 
are automatically associated with the chosen TIFF viewer program.  The client can open the fax email 
attachment directly in the TIFF viewer program. 

b. Saving the fax message graphic file.  In some TIFF viewer programs, the client can do a ‘Save 
As,’ renaming the TIFF file attachment with a meaningful name for subsequent viewing or forwarding. 

7. The client views the fax message in the TIFF viewer program. 

 

Receiving Faxes in PBX Routing Mode 

In PBX Routing Mode, the FaxFinder Server delivers incoming faxes to client PCs in their email inboxes. 

1. A PBX extension number must be assigned to the client PC at the FaxFinder Server.   

2. For fax reception, the client PC and the FaxFinder server need not both be connected to the same 
Ethernet LAN system.  (A sales representative, for example, could receive faxes sent to her home 
office fax number even though she is traveling overseas, if she uses an Internet email account.)  

3. A fax document is sent to the PBX extension number of a client/recipient on the FaxFinder system.  
The fax call is routed to the FaxFinder server and there converted to a TIFF file.  The TIFF file is 
attached to an email message that is sent to the intended recipient’s email address (as specified in 
the FaxFinder Phone Book). 

4. The incoming fax arrives in the recipient’s email inbox as a message with an attachment. 

The email message is marked as being from the FaxFinder Administrator. 

The sender’s “Remote ID” and the recipient’s name appear in the “Subject” line of the email 
message.  (The Remote ID comes from the sending fax machine and is typically the sender’s fax 
number or name.)    
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5. The fax recipient (a client of the FaxFinder Server) opens the email message.  The incoming fax 

message takes the form of a graphic file attachment.  The FaxFinder Server has assigned the file an 
automatic file name. 

6. The FaxFinder client can open the file or save the file. 

a. Opening the fax message graphic file.  Incoming fax messages are TIFF files.  These TIFF files 
are automatically associated with the chosen TIFF viewer program.  The client can open the fax email 
attachment directly in the TIFF viewer program. 

b. Saving the fax message graphic file.  In some TIFF viewer programs, the client can do a ‘Save 
As,’ renaming the TIFF file attachment with a meaningful name for subsequent viewing or forwarding. 

7. The client views the fax message in the TIFF viewer program. 

 

 

 



Chapter 3 – FaxFinder Client Software Operation 

Multi-Tech Systems, Inc.             FF200 FaxFinder Client User Guide 46 

Using the Multi-Tech Tiff Viewer 
The Multi-Tech Tiff Viewer program has a variety of features that enhance the viewing of fax messages in 
graphic file form (thumbnails, zooming, spot magnification, scrolling, rotating, etc.).  The program can also 
manipulate and permanently alter the graphic files. 

Frequently Used Commands – Toolbar Icons 

The most commonly used functions are available as icons on the toolbar.  In the next three diagrams, we 
label and describe the functions of these icons.  
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While most of these features are common to many graphical programs, some warrant a bit of explanation. 

Copy.  The Copy function allows you to copy the fax file and insert it into a different application program.  
See “Importing Fax Images into Other Application Programs” below. 

Panning (Omni-Directional Scroll).  The “hand” icon allows you to bring any desired portion of the image 
into view. 

 

Zoom to Selection.  Click and drag with the mouse over the rectangular area you would like to view.  
The Multi-Tech Tiff Viewer zooms in sufficiently to fill the screen with the selected area. 
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Spot Magnifying Glass.  In this viewing mode, a magnifying glass icon (cursor) appears.   

 
It can be used in one of three ways to magnify any portion of the image: (a) Click over Area, (b) Click-and-
Hold Over Area, (c) Scan the Graphic. 

Click over Area.  A secondary window will appear that shows the ‘clicked-on’ area magnified.  You can 
adjust the size of the secondary window by dragging on its borders.  You can re-locate the secondary 
window by putting the cursor inside the window, clicking, holding, and dragging. 
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Click-and-Hold over Area. Two additional windows will appear.  The cursor itself becomes a small 
secondary window of fixed size.  The same image also appears on a third window. You can adjust the 
size of the secondary window by dragging on its borders.  You can re-locate the secondary window by 
putting the cursor inside the window, clicking and dragging.   

 
Scan the Graphic.  If you click, hold, and drag, you can scan the image in a magnified view.  Two 
magnifying windows will appear as in the “Click-and-Hold Over Area” description above. 
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Setting Up Your Address Book Manually 
The Address Book in the FaxFinder Client Software adds significant convenience to the system.  When 
recipient contact information has been entered in the Address Book, this information will appear 
automatically in the corresponding fields of the fax cover page. 

1. In the FaxFinder Fax Client Software screen, click on the “Address Book” tab. 

2. In the Edit menu, select “Add Contact.” 

3. In the appropriate fields of the New Contact screen, enter information about the fax recipient. 

 
 

4. After an entry has been made in the Address Book, you can view and revise it.  In the Address Book 
list, right-click on the name of the contact about whom you wish to review address information and 
select Properties. 
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5. A Contact – Recipient screen will appear presenting the contact info for this particular recipient. 

 
6. When you click on “Address Book” at the FaxFinder Send Fax screen, this same contact list will 

appear.   

 
7. When you select an item from this list and select Use Cover Page, contact info will be added 

automatically to the appropriate fields of the cover page. 

 
8. To delete an entry from your Address Book, select the entry and right-click on it.  In the menu that 
appears, select delete. 
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Setting Up Your Address Book by Synchronizing with 
Outlook 

What Synchronization Means 

During synchronization, entries from the FaxFinder Client Address Book and from the specified folder of 
MS Outlook are merged into one list saved in both applications.  When “Synchronize With Outlook” 
command is invoked in the FaxFinder Client software, each list is updated with changes from the other. 

 

Synchronization Procedure 

1. In Microsoft Outlook, view the folder from which you want to be able to transfer fax numbers to the the 
FaxFinder Client Address Book.  Confirm that you want those entries in your FaxFinder Client 
Address Book. If so, proceed.  (For example, you might select the “Contacts” folder in Outlook as 
your source of existing fax numbers). 

2. In the FaxFinder Fax Client Software, go to File | Options |Advanced and click on “Enable Outlook Sync.”   
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3. Click on Browse. Select the desired folder from the Select Contact Folder (Outlook:) screen.  Click 
OK.  If a confirmation screen appears, click OK.   

 
At the Options screen, click OK. 

 

4. In the FaxFinder Fax Client Software, go to the Device Status tab and select Outlook Synchronizer 
in the “Device” list. 
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5. Right-click on Outlook Synchronizer and select Synchronize with Outlook. 

 The Outlook Contact information will be copied into the FaxFinder Address Book.  Entries from the 
FaxFinder Address Book (if any) will also be copied into the Outlook Contact list.  A relationship will 
be created between the corresponding entries for future synchronizations. 

 The Outlook Synchronizer feature has many options.  For further details, see the Administrator User 
Guide.     
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Using Stock Cover Pages 
Faxes are often accompanied by a cover page that specifies from whom it was sent, to whom it was sent, 
the date, and other details about the sending and receiving parties.  The FaxFinder system offers several 
ready-made (stock) cover pages that can be used for this purpose.  These stock cover pages can also be 
modified or customized to meet individual needs (see “Creating or Modifying Cover Page Styles” later in 
this chapter). 

In this section, we present an example of using a stock cover page. 

1. We will send the fax from the Windows Notepad program.  (In this program, one sets the printer by 
going to File | Page Setup | Printer | Properties | Name and, in the drop-down list, set “Multi-Tech 
FaxFinder” as the target printer, and click OK).   

 
2. In Notepad, we select Print to send the file as a fax via the FaxFinder. 
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3. When the FaxFinder Send Fax screen appears, it will list the document we want to fax in its 
“Documents” pane.  Next we must specify a recipient.   

The recipient could either be chosen from the Address Book or specified directly in the Name and Phone 
Number fields using the Add Recipient command in the FaxFinder Send Fax screen.   

In this example, we will choose the recipient from the Address Book by highlighting the entry and clicking 
Select.  Note the detailed address information about the recipient that had been stored when this party 
was entered into the Address Book (you can view the details on any Address Book entry by clicking Edit 
from the Address Book screen).  Recipient contact info from the Address Book entry will appear later in 
the automated fields of the cover page.  Sender contact info from the Options menu will also appear on 
the cover page.  Which details are included in the cover page depends on the cover page style used.  
The “fax stamp” at the top of each sheet of the fax (which includes sender, recipient, and time info) is 
inserted automatically based on information from the FaxFinder server software and from the recipient fax 
machine. 
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4. The FaxFinder Send Fax screen appears again but this time our recipient has been entered. 
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5. Since we intend to use a cover page, we click “Use Cover Page” and then select a stock cover page 
from the “Cover Page Style” drop-down list.  We can then type a subject for the fax message and type a 
cover page note, each in the appropriate fields. 
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Suppose we choose the style called “BoldComplete.”  We can view it by clicking View/Edit. 
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6. To see how the cover page appears after the sender and recipient information has been automatically 
inserted, click Preview Fax.  This is how the fax cover page will be sent. 

 
 

7. To send the fax, simply click Send Fax in the FaxFinder Send Fax screen. 
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Creating or Modifying Cover Page Styles 
The Multi-Tech Cover Page Generator program allows you either to produce custom cover pages or to 
use existing style templates. In this section, we will describe both processes, making a new template and  
customizing an existing stock cover page style template.  

Creating New Cover Page Templates 

1. Open the Cover Page Generator program.  Go to Start | Programs | FaxFinder Client Software | 
Cover Page Generator.  You can also open the Cover Page Generator program from the FaxFinder 
Fax Client Software program by  opening the Edit menu and selecting “Edit Cover Page Template.” 
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2. The main Template Editor screen will appear.  Open it to full-screen size. 
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3. Several types of objects can be added to a cover page file.  These are listed in the Objects pulldown 
menu.   

 
 The commands to create these objects can be invoked either here or from buttons on the Tool Bar.  

We will invoke various commands from  these toolbar buttons throughout this procedure.  

4. Decide on the categories for which you want automated fields on the fax cover page.  Generally 
speaking, you will want to include information about the Sender and the Recipient.  For each type of 
information, you will want a label in “Static Text” and an “Edit Box” into which the automated 
information will go. Information about the sender will be automatically transferred from the FaxFinder 
Client Software Options screen onto the cover page; information about the recipient will come to the 
cover page from the FaxFinder Address Book’s Contact screen or from the FaxFinder Send Fax 
screen (if the Add Recipient button is used to specify the fax recipient); and occasional information 
will come from the FaxFinder Send Fax screen (for the subject of fax and the comment) and from the 
client PC (for the date of the fax).   
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To insert an automated field, you must click on the “Edit Box” button and then drag open a box at the 
desired place on the screen.  Typically, one would place the label of the category using  the Static 
Text icon first and then locate the Edit Box beside it.   

Static Text Icon  Edit Box Icon 

 

 

 

 

The FaxFinder supports the automated field types listed in the table below. 

Field Type Source of Info Placed in 
Field 

Description 

T_FROMNAME FF Client Options screen Sender’s Name 

T_FROMCOMP FF Client Options screen Sender’s Company Name 

T_FROMPHONE FF Client Options screen Sender’s Voice Phone Number 

T_FROMFAX FF Client Options screen Sender’s Fax Number 

T_TONAME FF Client Contact screen or 
Send Fax screen 

Recipient’s Name 

T_TOCOMP FF Client Contact screen Recipient’s Company Name 

T_TOPHONE FF Client Contact screen Recipient’s Voice Phone Number 

T_TOFAX FF Client Contact screen or 
Send Fax screen 

Recipient’s Fax Number 

T_DATE client’s PC Date of Fax Transmission 

T_SUBJ FF Client Send Fax screen Subject of Fax Message 

T_COMM FF Client Send Fax screen Comment about Fax Message 

T_TOADDR1 FF Client Contact screen Recipient’s Street Address 

T_TOCITY FF Client Contact screen Recipient’s City 

TO_STATE FF Client Contact screen Recipient’s State/Province/County, etc. 

T_TOZIP FF Client Contact screen Recipient’s ZIP code or postal code 

 

 

5. Select the “Static Text” cursor labeled N and drag to open the desired field.   
 

 

 To have freedom to move the cursor in a continuous fashion leave the Grid button, 
 

, in 

the unselected position (its darker shade represents its unselected state).  You can also turn the Grid 
on and off in the Settings pull-down menu. 
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6. Enter the field label in the Static Text box.  Be sure to allow enough room for the size of font you have 
chosen.  If the box is too small for the font size, the text will be cut off. 

    To select font, the font style, and font size, use the  
 

cursor. 

 You can also access font settings from the Settings pulldown menu. 

To align the text to the left edge, right edge, or center of the box, use the 

 
cursor. 

 

For example, you might create a static text item of the word “Date.”  To move the box, click on it and 
move it when the 4-direction cursor appears.  To expand or contract the box, click on it and drag an 
edge or a handle until the desired size/shape is achieved. 
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7. Select the “Edit Box” cursor labeled ab and drag to open the desired field. 
Double-click on the box you have opened.  The Item ID screen will appear.  Scroll down the list and 
highlight the field type (listed in the “Type” drop-down list) that you want on the cover page.  There is 
no need to use the “Title” field.  Click OK. 

You will not type anything in the Edit Box that appears on the screen.  However, be sure to make the 
Edit Box large enough for the font size you have chosen.  If the box is too small for the font size, the 
text will be cut off. 

To follow our example, you would select “T_DATE” to insert a date field next to the “Date” label you 
have previously placed on the page. 
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     You might want the automated field value to be placed on a line or in a rectangle.  If so, you could 
use the line cursor to put a line beneath the edit box or use the rectangle cursor to place a rectangle 
around the edit box.  You can place lines, rectangles, and ellipses on the page for any purpose.  
Rectangles and ellipses can have a solid fill or a shading (called “hilight”).  These graphic functions 
are described in the table below. 

 

Shape Cursors: 
 

 

  A B C D E   

 

A. Line B. Rectangle C. Ellipse D. Hilight shape E. Fill shape 

Use to draw Use to draw 
rectangles. 

Use to draw 
ellipses. 

Not supported. When selected, 
any rectangle or 
ellipse made will 
have a black fill.  

 

To set the line width for lines, rectangles, and ellipses, use the drop-down box at the far-right of the 
Template Editor’s tool bar.  (You need to have the screen open widely enough to see its entirety.) 
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  8. To add a graphic file to the cover page template, click on the Image icon 
 . 

Then browse to the directory that contains the desired graphic file.  Files of type  bmp and tif can be 
inserted into cover pages. 

Insert graphics files into your cover page template as needed. 

9. Save the file to the Cover Pages directory in your operating system.  The .cpg file must be saved in 
this location in order for it to be accessible to the FaxFinder client software.  When saved to this 
location, the file name of the customized cover page template you have created will appear in the 
“Cover Page Style” drop-down list on the FaxFinder Send Fax screen. 

 In general, you should save to C:\ <windows install path> \ profiles \ <username> \ Application Data \ 
Fax Finder Client <Software> \ Cover Pages 

If you used the default installation path for Windows NT or Windows 2000, save to 
C:\winnt\Profiles\<user name>\Application Data\FaxFinder Client Software\Cover Pages. 

If you used the default installation path for Windows XP, save to  
C:\Documents And Settings\<username>\Application Data\Fax Finder Client\Cover Pages. 

 

10. We advise previewing and printing your custom cover page template using the Multi-Tech Tiff Viewer 
program rather than the Template Editor program. 

 The illustration below shows how the fields specified in the Template Editor program will be filled out 
when the template is used at the FaxFinder Client Send Fax screen.  The item ID tags for common 
field types are specified. 
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Modifying Existing Cover Page Templates 

Note:  While all five stock cover page styles can be readily customized, the styles 
“PlainComplete” and “PlainShort” are especially well suited to customization.  In most 
cases, one can start with these files and simply add one’s own company name in text or 
insert one’s graphical company logo. 

1. Open the Cover Page Generator program.  Go to Start | Programs | FaxFinder Client Software | 
Cover Page Generator.  You can also open the Cover Page Generator program from the FaxFinder 
Fax Client Software program by  opening the Edit menu and selecting “Edit Cover Page Template.” 

 
2. In the File menu, select “Load.”  Browse to the directory into which the FaxFinder client software has 

been installed.  Typically, this will be C:\Program Files \ Multi-Tech Systems \ FaxFinder Client 
Software \ Cover Pages.  Select a cover page template from the list. 

For our example, we will use the cover page template file FaxComplete.cpg. 

3. In the File menu, select “Save As” and rename the file, saving it in the ‘Application Data’ directory for 
the FaxFinder client software. This will vary for different Windows operating systems. (For Windows 
NT4/2000, this will be C:\Winnt \ Profiles \ <username> \ Application Data\ FaxFinder Client Software 
\ Cover Pages.  For Windows XP, this will be C:\Documents And Settings\<username>\Application 
Data\Fax Finder Client\Cover Pages.)   
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For our example, we will rename the file rmc1.cpg, for the purposes of our fictitious company, Rocky 
Mountain Construction, Inc. 

 
4. You can use the Tab key to skip from field to field in the template.  Note, however, that any values 

added to template fields will be overwritten by values specified in the Address Book (in “New Contact” 
screens launched from Edit | Add Contact in the FaxFinder Fax Client Software program). 
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5.  Add company logo at top of cover page. 

For our example, we will add the graphic file “ff-rocky-mtn-logo1.bmp” to the cover page. 

In the Objects menu of the Template Editor, select “Image.” 
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Browse to the location of the graphics file to be used.  Click Open. 

Move the + cursor to the desired location of the graphic.  Then click and drag to size the graphic.  Click 
and drag on the cursor dots on the periphery of the image to resize it and set its vertical/horizontal aspect 
ratio. 
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6. Add company slogan to bottom of template.  

For the purposes of our fictitious company, Rocky Mountain Construction, Inc., we will use the slogan 
“Building on New Horizons.” 

Select the “Static Text” cursor labeled N and drag 
to open a text box at the bottom of the template page. 

Enter the slogan. 
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7. In the File menu, select “Save As” and overwrite the file using the same filename used in step 3, 
saving it in the ‘Application Data’ directory for the FaxFinder client software.  (For Windows 
NT4/2000, this will be C:\Winnt \ Profiles \ <username> \ Application Data\ FaxFinder Client Software 
\ Cover Pages.  For Windows XP, this will be C:\Documents And Settings\<username>\Application 
Data\Fax Finder Client\Cover Pages.) 

For our example, we will overwrite the file using the file name rmc1.cpg, which befits the purposes of 
our fictitious company, Rocky Mountain Construction, Inc. 

8. To use your customized template when sending a fax, you must click “Use Cover Page” in the 
FaxFinder Send Fax screen.  Then scroll through the “Cover Page Style” list to find the file name of 
the custom template you have created.  In our example, it is rmc1.   
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9. When the fax is sent, the ‘automated’ fields on the cover page template will be filled in with 
information from the Address Book (if the recipient is listed there).  Click on “Preview Fax” in the 
FaxFinder Send Fax screen to examine the fax with cover page. 
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Cover Page Generator Menu/Icon Command Descriptions 

 
 

FaxFinder Cover Page Generator Software Menu Command Definitions (cont’d) 
Command Name Icon Description 

File Menu commands  
New 

 
Creates new cover page template file. 

Load 
 

Opens an existing cover page template file for 
viewing or editing. 

Save 
 

Saves cover page cpg file at current path. 

Save As -- Saves cover page cpg file at new path that user 
specifies. 

Print  
 

Not supported.  Use Multi-Tech Tiff Viewer to 
print cover page templates. 

Exit 
 

Closes current cover page template file and 
closes program.  User is prompted to save. 
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FaxFinder Cover Page Generator Software Menu Command Definitions (cont’d) 

Command Name Icon Description 
Edit menu commands  

Image 
 

Use to insert a bmp or tif image into the cover 
page template. 

Edit Box 
 

Use to insert an automated field into the cover 
page template.  The values inserted into 
automated fields come from FaxFinder Address 
Book, FaxFinder Send Fax screen, from client 
user’s PC, and from the remote fax sender. 
When you create a new Edit Box, you must 
select it and double-click on it to make the Item 
ID screen appear.  It is in the Item ID screen that 
you specify which type of information will be 
placed in this position on the fax cover page.  
Use icons to align text to left, center, or right.  
Use “Font” icon or command in Settings menu to 
alter font, font size, and font style. 

Static Text 
 

Use to insert text objects needed in the cover 
page template.  These uses include labels for 
automated fields (TO, FROM, DATE, etc.) and 
plain text like a company name or slogan. Use 
icons to align text to left, center, or right.  Use 
“Font” icon or command in Settings menu to 
alter font, font size, and font style. 

Line 
 

Use to insert line objects into the cover page 
template.  Use Line Size drop-down menu at far 
right of screen to select width of lines. 

Rectangle 
 

Use to insert box objects into the cover page 
template. Use Line Size drop-down menu at far 
right of screen to select width of lines. 
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FaxFinder Cover Page Generator Software Menu Command Definitions (cont’d) 

Command Name Icon Description 
Edit menu commands  

Ellipse 
 

Use to insert circles or elliptical objects into the 
cover page template.  Use Line Size drop-down 
menu at far right of screen to select width of 
lines. 

Hilite 
 

Not supported. 

Filled Object 
 

When selected, rectangles and ellipses created 
will have black fill. 

deleting objects -- Use the keyboard Delete key to delete a 
selected object. 

Line Size drop-down 
menu 

 Use to select line widths for line objects, 
rectangle objects, and ellipse objects. 
This icon is located at the far right on the screen. 
You may need to open the program to “Full 
Screen” view to see this drop-down menu. 

 

 
 

FaxFinder Cover Page Generator Software Menu Command Definitions (cont’d) 
Command Name Icon Description 

View Menu commands  
Zoom In 

 
Use to view a smaller area of the cover page 
template file in greater magnification.   

Zoom Out 
 

Use to view a larger area of the cover page 
template file in a lesser magnification. 

Fit to Width -- Use to get magnification of file such that its 
horizontal dimension fits proportionally into the 
window. 

Fit in Window -- Use to get magnification of file such that the 
entire cover page template fits proportionally into 
the window. 

Toolbar -- Use to show or hide toolbar of command icons. 
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FaxFinder Cover Page Generator Software Menu Command Definitions (cont’d) 
Command Name Icon Description 

Settings Menu commands  
Font 

 
Brings up Font dialog box in which font, font size, 
and font style can be set. 

Grid 
 

Use to turn grid on and off.  If grid is off, objects 
can be positioned in cover page in a continuous 
fashion.  If grid is on, objects can only be 
positioned at discrete grid coordinates. 
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Reporting Failed Faxes to the Administrator  

Occasionally clients will receive email messages from the FaxFinder that pertain to faxes that have failed 
partially or entirely.  That is, some or all of the intended pages of the fax may arrive in a form that cannot 
be read.  Here is the sequence of events you may encounter and the proper response. 

1. The client user receives an email message from the FaxFinder about a partially or wholly failed fax sent 
to him/her.  

2. Advise the sender of the fax to re-send all or part of the fax.  

3. If the fax was only partially a failure, then TIFF files for the successful pages will be attached.  If any 
pages of the fax failed, then an additional file will be attached to the email message.  It will have a name 
like modem0modem1_date-time.txt.  This is the modem log file. 

4. The modem log file contains information about the “conversation” between the sending modem and the 
FaxFinder’s receiving modem.  This information may be valuable to the FaxFinder administrator in 
protecting the fax system and preventing future errors. 

5. The client user should forward the modem log file to the FaxFinder administrator in an email message.  
The FaxFinder administrator’s email address should be viewable in any fax you have received via the 
FaxFinder. 
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Chapter 4: Warranty, Service, & 
Repair 

 
 

Multi-Tech Warranty Statement 
Multi-Tech Systems, Inc., (hereafter “MTS”) warrants that its products will be free from defects in material 
or workmanship for a period of two, five, or ten years (depending on model) from date of purchase, or if 
proof of purchase is not provided, two, five, or ten years (depending on model) from date of shipment.  
MTS MAKES NO OTHER WARRANTY, EXPRESS OR IMPLIED, AND ALL IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED.  
This warranty does not apply to any products which have been damaged by lightning storms, water, or 
power surges or which have been neglected, altered, abused, used for a purpose other than the one for 
which they were manufactured, repaired by Customer or any party without MTS’s written authorization, or 
used in any manner inconsistent with MTS’s instructions.  
MTS’s entire obligation under this warranty shall be limited (at MTS’s option) to repair or replacement of 
any products which prove to be defective within the warranty period or, at MTS’s option, issuance of a 
refund of the purchase price. Defective products must be returned by Customer to MTS’s factory — 
transportation prepaid.  
MTS WILL NOT BE LIABLE FOR CONSEQUENTIAL DAMAGES, AND UNDER NO CIRCUMSTANCES 
WILL ITS LIABILITY EXCEED THE PRICE FOR DEFECTIVE PRODUCTS.  

Repair Procedures for U.S. and Canadian Customers 
In the event that service is required, products may be shipped, freight prepaid, to our Mounds View, 
Minnesota factory:  
Multi-Tech Systems, Inc.  
2205 Woodale Drive  
Mounds View, MN 55112  
Attn: Repairs, Serial # ____________  
A Returned Materials Authorization (RMA) is not required. Return shipping charges (surface) will be paid 
by MTS to destinations in U.S. and Canada. 
Please include, inside the shipping box, a description of the problem, a return shipping address (must 
have street address, not P.O. Box), your telephone number, and if the product is out of warranty, a check 
or purchase order for repair charges.  
For out of warranty repair charges, go to www.multitech.com/DOCUMENTS/Company/warranty/  
Extended two-year overnight replacement service agreements are available for selected products. Please 
call MTS at (888) 288-5470, extension 5308 or visit our web site at 
www.multitech.com/PARTNERS/Programs/orc/ for details on rates and coverage’s.  
Please direct your questions regarding technical matters, product configuration, verification that the 
product is defective, etc., to our Technical Support department at (800) 972-2439 or email 
support@multitech.com. Please direct your questions regarding repair expediting, receiving, shipping, 
billing, etc., to our Repair Accounting department at (800) 328-9717 or (763) 717-5631, or email 
mtsrepair@multitech.com.  
Repairs for damages caused by lightning storms, water, power surges, incorrect installation, physical 
abuse, or user-caused damages are billed on a time-plus-materials basis.  

Repair Procedures for International Customers (Outside U.S.A. and Canada)  
Your original point of purchase Reseller may offer the quickest and most economical repair option for your 
Multi-Tech product. You may also contact any Multi-Tech sales office for information about the nearest 
distributor or other repair service for your Multi-Tech product. The Multi-Tech sales office directory is 
available at www.multitech.com/PARTNERS/Channels/offices/  
In the event that factory service is required, products may be shipped, freight prepaid to our Mounds 
View, Minnesota factory. Recommended international shipment methods are via Federal Express, UPS or 
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DHL courier services, or by airmail parcel post; shipments made by any other method will be refused. A 
Returned Materials Authorization (RMA) is required for products shipped from outside the U.S.A. and 
Canada. Please contact us for return authorization and shipping instructions on any International 
shipments to the U.S.A. Please include, inside the shipping box, a description of the problem, a return 
shipping address (must have street address, not P.O. Box), your telephone number, and if the product is 
out of warranty, a check drawn on a U.S. bank or your company’s purchase order for repair charges. 
Repaired units shall be shipped freight collect, unless other arrangements are made in advance.  
Please direct your questions regarding technical matters, product configuration, verification that the 
product is defective, etc., to our Technical Support department nearest you or email 
support@multitech.com. When calling the U.S., please direct your questions regarding repair expediting, 
receiving, shipping, billing, etc., to our Repair Accounting department at +(763) 717-5631 in the U.S.A., or 
email mtsrepair@multitech.com.  
Repairs for damages caused by lightning storms, water, power surges, incorrect installation, physical 
abuse, or user-caused damages are billed on a time-plus-materials basis.  

Repair Procedures for International Distributors  
Distributors should contact Amex, Inc., for information about the repairs for your Multi-Tech product.  

Amex, Inc. 
2724 Summer Street NE 
Minneapolis, MN 55413 U.S.A. 
Tel: +(612) 331-3251 
Fax: +(612) 331-3180 
Email: info@amexinc.com 

Please direct your questions regarding technical matters, product configuration, verification that the 
product is defective, etc., to our International Technical Support department at +(763)717-5863. When 
calling the U.S., please direct your questions regarding repair expediting, receiving, shipping, billing, etc., 
to our Repair Accounting department at +(763) 717-5631 in the U.S.A. or email mtsrepair@multitech.com. 
Repairs for damages caused by lightning storms, water, power surges, incorrect installation, physical 
abuse, or user-caused damages are billed on a time-plus-materials basis.  
 
 
 
 
 


